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RF Explorer®

 

 

RF Explorer is an affordable Handheld Spectrum Analyzer with a growing list of features.  

 

This little powerful unit is the tool you need  

to reduce the implementation time and cost  

of your next wireless project. 

 

 

 

 

 

Updates of the RF Explorer User Manual are available online. 

Please consider the environment before printing this document.  

http://www.rf-explorer.com/download
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Version 1.15.1610.4 

 Recommended RF Explorer Spectrum Analyzer firmware: v1.16B03 or v1.15 

 Recommended RF Explorer Signal Generator firmware: v1.15 

 Note: WindowsXP computers may need to apply a Microsoft Hotfix to properly install this 

version. Please install software from WindowsXP_MSI45_Hotfix.zip if normal install fails in 

WindowsXP. 

Enhancements: 

 This version introduces RF Data Sniffer capabilities as Beta feature. In order to use Sniffer 

features, please read the document “RF Explorer for Windows DRAFT Documentation - 

sniffer.pdf” included in this release package. 

 
 To enable Sniffer data you need to upgrade RF Explorer Spectrum Analyzer to firmware 

v1.16B03 – you can easily downgrade it to v1.15 anytime. 
 Several enhancements in Markers: 

o Markers allow now Delta value reading – you can display difference between two 

markers as delta in dB. This is useful to measure harmonic, noise levels, carrier dBc, etc. 

 
o Markers can be allocated on screen at any arbitrary frequency with a double-click mouse 

(not available for auto-peak Marker 1) 

o Marker display is now better organized, display is now bold for marker label in the right 

marker data control area. 

 Display grid now include a continuous line trace for major grid ticks. In earlier versions this was 

presented with dotted lines which made it hard to read at certain wide zoom configurations. 

 Updated to latest OpenGL libraries to enable maximum compatibility with video card drivers. 
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Bug Fixes: 

 

 Fixed problem with Windows Text Scale different than 100% in Windows Vista and Windows 7. 

Before this fix, some Text Scale OS settings such as 125% or 150% may lead to inconsistent 

Zoom selection inside Spectrum Analyzer or RF Sniffer data graphs. 

 Fixed a performance problem when displaying Spectrum Analyzer graphs with a very narrow 

span (<1MHz) in some configurations. After this fix the display performance is independent of 

selected span. 
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Version 1.15.1607.6 

 Recommended RF Explorer Spectrum Analyzer firmware: v1.15 

 Recommended RF Explorer Signal Generator firmware: v1.15 

Release date: CET July 31st , 2016 

Bug fixes 

 Fixed a problem where Frequency Calibration (from Configuration screen tab) would not 

correctly calibrate 3G Combo model. 

 Improved numeric check in several Analyzer and Generator edit boxes. 
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Version 1.15.1607.5 

 Recommended RF Explorer Spectrum Analyzer firmware: v1.15 

 Recommended RF Explorer Signal Generator firmware: v1.15 

Release date: CET July 8th, 2016 

 

Enhancements: 

 Included full support for Frequency and Amplitude Sweep using RF Explorer Signal 

Generator v1.15 – for more details check Signal Generator user manual 
 Added ToolGroups for Amplitude Sweep and Frequency Sweep in Signal Generator tab 

screen 

 

 RF Explorer Signal Generator now disables LCD backlight and announce TRACKING + 

POWER ON to alert on current functionality when working in SNA mode. 

 Finished final release for Signal Generator features with production quality, no software 

stage is in beta level beyond this point. 
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Bug fixes 

 RF Explorer for Windows now remembers last computer folder used to read and write files. 

Before this fix, default location in My Documents was always suggested for file location, this 

was inconvenient when a different folder was intended to be used. 

 The Report tab now correctly dump screen contents from Signal Generator or Spectrum 

Analyzer. Note: to capture Signal Generator screen, make sure a Spectrum Analyzer is not 

connected at the same time. 

 The Spectrum Analyzer tab now correctly adjust Top amplitude when an external attenuator 

or amplifier is being used, and OffsetDB was specified in the unit. Before this fix, the Top 

amplitude may not be enabled to increase in a way that correctly display high power levels. 
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Version 1.12.1604.3 

 Recommended RF Explorer Spectrum Analyzer firmware: v1.12 Beta 31 

 Recommended RF Explorer Signal Generator firmware: v1.12 Beta 15 

Release date: CET Apr 13th, 2016 

 

Enhancements: 

 Automatic connection of Spectrum Analyzer and Signal Generator device. This is a major 

improvement to allow transparent operation of connected devices in any configuration. If you 

are using a RF Explorer Spectrum Analyzer and a Signal Generator together for SNA or other 

purposes, the easiest way to work with them now is as follows: 
o Connect Spectrum Analyzer to USB 
o Connect Signal Generator to USB 
o Start RF Explorer for Windows application. 
o Both devices will be automatically connected to correct ports and enable SNA display 

automatically. 

 Manual connection of devices is still available as usual, in all cases the application will try to 

connect the right device to the right port as soon as the connection is made. 

 Aligned waterfall 2D view on main Spectrum Analyzer screen. Now is possible to have a fully 

aligned frequency view on both displays. 

 Waterfall dedicated tab view is now independently configured from that of Spectrum Analyzer 

tab view. This is best fit for a convenient 2D waterfall on Spectrum Analyzer and a full featured 
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3D view on Waterfall view. Configuration settings such as transparency and Realtime/MaxHold 

settings for waterfall are also independent in both views. 

 

 Default settings are now Dark Mode and Spectrum Analyzer view configured to include waterfall 

2D. This setting can be reconfigured by user anytime. If you do not need or like the Waterfall 

view, use menu View->Include Waterfall in Main Screen->None. 

 Configuration device icon is now disabled by default, to allow waterfall alignment. You can 

enable the device icon again using menu Device->Show RF Explorer icon… 

Bug fixes 

 Waterfall screen display is now properly updated when “Data Sample” index is manually 

modified while Hold mode is enabled. Before this fix, waterfall display may not update with 

correct data when Data Sample was manually modified. 

 Frequency Markers are invalidated in Wifi Mode if they are out of range. Before this change, 

some markers could read incorrect values while Wifi Analyzer mode was enabled. 

 Frequency Markers no longer get out of screen if too many are enabled. Before this fix, a long 

list of markers on screen may actually go beyond application markers area. 
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Version 1.12.1601.5 

 Recommended RF Explorer Spectrum Analyzer firmware: v1.12 Beta 26 

 Recommended RF Explorer Signal Generator firmware: v1.12 Beta 15 

Release date: CET Jan 29th, 2016 

Release notes for this version accumulate a number of improvements and bug fixes, including 

details from earlier versions v1.12.x not fully documented in this document before. 

 

Enhancements: 

 Fully supported SNA tracking for all RF Explorer models except 2.4G. This model will be 

supported in the near future. 

 Added median average to improve noise rejection in SNA tracking display. 

 Software is fully integrated with internal calibration available in RF Explorer Spectrum 

Analyzer and RF Explorer Signal Generator. Please upgrade your unit to latest firmware 

versions available at www.rf-explorer.com/downloads  

 RF Explorer firmware uploader tool is now supported in Linux, Windows and MacOS X. For 

more details please visit www.rf-explorer.com/upgrade . This tool now also support 

command line mode for easy use in headless devices such as Raspberry Pi and remote 

servers – you can now virtually upgrade your RF Explorer firmware from any system! 

 Support for configurable and auto-generated Limit Lines, including optional sound alarm 

when signal does not fit inside limit lines. 

 Normalization data can be fully stored in separated files for easy reuse later. 

 Signal Generator tracking results can be saved as CSV and standard S1P files. Note: files are 

considered S1P because only one parameter can be saved at a time, regardless if it is S11 or 

S21. If it is a 2-port S21 measurement, rename the file manually. Future enhancements will 

http://www.rf-explorer.com/downloads
http://www.rf-explorer.com/upgrade
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allow combination of multiple readings, such as S11 and S21 to be displayed together and 

saved to a S2P file. 

 User can select "Insertion Loss" or "Return Loss" graphical Y axis label for Signal Generator 

trace. This include "Linear VSWR" correctly calculated for easy VSWR display. Note: you 

need an external directional coupler to measure return loss and VSWR as described in this 

online tutorial: link. 

 

 All Tool Groups in control area are now collapsible to make it easier fit in small screens. This 

feature is developed from ground up specifically for RF Explorer for Windows. As depicted in 

the image, circled in red, there is a new arrow button available on each toolset group and 

located top-right; by clicking on it you can collapse the toolset so no longer takes screen 

space and makes room available for other controls. 

 

Once collapsed, the toolset group will display a brief informative text. In this case to show 

the Analyzer is connected (Analyzer ON). By clicking again on the arrow button the toolset 

group gets expanded back. 

 

http://j3.rf-explorer.com/43-rfe/how-to/139-sna-how-to-measuring-reflection-return-loss
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 This version adds Tool Group for Markers, so it is now easier than ever to set a marker 

quickly on screen (optionally you can use Markers menu as in earlier versions) 

 

 Markers are available for SNA Tracking as well as Spectrum Analyzer. They work virtually the 

same in Spectrum Analyzer and SNA, with the important difference in marker 1: while it 

detects Peak value in Insertion Loss mode, it will automatically change to negative Peak in 

Return Loss mode. 

All other markers from 2-9 can be defined at any arbitrary frequency, same as with 

Spectrum Analyzer. Values of markers defined for SNA and Spectrum Analyzer are 

independent and stored in configuration settings, so you can define markers for a particular 

configuration and restore them easily anytime. 

 

 Added Tool Group for most usual visual settings including different trace modes as well as 

signal thickness, grid, etc. 

 

 Added on-screen tooltips for most controls and functions. To use them and get sensitive 

help, just place the mouse cursor over any control and will display informative text. 

 Remote Screen tab is now available for Signal Generator too. In order to use it, the only 

device connected must be the Signal Generator, otherwise the Spectrum Analyzer takes 

precedence. 

 Waterfall screen supports now arbitrary data points. This enable data from RF Explorer 

RackPRO and other future models and firmware revisions to properly display large datasets 

in the Waterfall screen. 
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 Optimized internal data calculation and RAM storage for Waterfall screen. This may be 

noticeable for a better performance and lower memory footprint in small systems such as 

Windows tablets and netbooks. 

 Sweep frequency and power settings are now stored with named configuration settings 

 User configurable title text graph added to both spectrum analyzer and SNA graph 

 Support for external amplitude correction files in Spectrum Analyzer. 

 Support for amplitude in dBm, dBuV and Watt. 

 Channel power meter 

 Additional remote device control modes 

 Auto-scale amplitude function using right-side accelerator buttons 

 Added all models correction files *.RFA so they are installed automatically, no need to 

manually handle them. 

 Updated power channel to adjust for OffsetDB from the device 

 Updated power channel to follow max/min range values from analyzer settings 

 Updated power channel context menu for correct option handling 

 Updated dark color mode to correctly read legends 

 WiFi Analyzer graph mode enabled. You can now use the WiFi analyzer mode on your PC as 

soon as it is enabled on the RF Explorer device. 

Fixes: 

 Fixed a problem where data files folder could not reliably use a network shared folder by 

default. 

 Corrected a scale fit problem in the RF Explorer device icon image in the Configuration Tab 

screen. 

 The configuration settings and user preferences configured in the RF Explorer for Windows 

application are now reused from version to version. 

 The application setup has been migrated to a different package. This should be transparent 

to all users and OS configurations but if you experience any problem in the setup process 

please contact us. 

 Corrected measurement data point on Signal Generator screen to be dB (as opposed to 

incorrect dBm reading earlier version) 

 Corrected Spectrum Analyzer trace color mismatch in MaxHold and Min. 

 Optimized communication response between device and USB connection to minimize 

configuration screen retries. Before this improvement, the device may resend configuration 

screen 2 or even 3 times to the Windows application, resulting in flashing and unnecessary 

refresh. 

 Fixes in markers under SNA on several cases where lost or changed unexpectedly 

 COM port larger to accommodate comfortably up to COM999 values 

 Fixed crash when editing dB value in Limit Lines dialog box 

 Automatic and resilient detection of any USB combination. Prior to this fix, the application 

may confuse ports and not complete connection if the device was plugged on a different 

USB port in the computer than last time used. 

 Typo in several message text and menus (thanks users Shaun O'Sullivan and Stewart 

Andreason) 
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 Sometimes SNA normalization or tracking could not start if frequency was right on module 

frequency boundary (e.g. starting right at 15MHz in a 3G Combo model may have not 

worked successfully in some cases) 
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Version 1.11.1311 

Release date: CET Nov 22nd, 2013 

This version includes important enhancements and features: 

 Waterfall 3D and 2D using high performance, high quality OpenGL graphics library. 

 

 Waterfall can display on dedicated tab as well as in the main Spectrum Analyzer screen, and 

options for display different perspective views and waterfall options are available on a right-

click, context sensitive menu. 
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 Signal shape in Spectrum Analyzer screen can be optionally filled with solid colors for easier 

visualization 

 Signal shape can optionally remove smoothing and use straight segments 

 Clean buffer option will now clean the internal RF Explorer device buffer as well to remove 

any old signal cached in MaxHold mode 

 Controls and Text in the Graphical Interface is adapted to resize correctly under text size 

scaled in Windows and has been thoroughly tested with different setups including 125% and 

150% text scale. 

 List of last data files .RFE opened are now available for easy access in the file menu. 

For more details, check the RF Explorer for Windows user manual online. 

  

http://www.rf-explorer.com/windows
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Version 1.11.1307 

Release date: CET Jul 24th, 2013 

This release includes full support for RF Explorer firmware v1.11, as well as new important 

capabilities: 

 Full compliance with firmware v1.11 – note some features will not be available if you do not 

upgrade your firmware to the latest version. 

 New Device menu with selection of active RF module if a 2-port RF Explorer model is 

connected. 

 Graphic, quality 3D representation of the connected RF Explorer model to better understand 

the active RF connector. It also includes an antenna representation but take the antenna 

shape as an indication only, the software has no way to know the actual antenna connected, 

or if there is an external RF source being used instead of an antenna. 

 The Spectrum Analyzer screen adds the currently selected Configuration Setting text as part 

of the title of the graph. This helps to reference the meaning of the captured signal in a 

print or a bitmap file. 

 Max Hold mode is available now in the View menu, in addition to the pre-existing Max Peak 

mode. 

 The Automatic LCD OFF option has been moved to the new Device menu. This is for 

consistency but functionality does not change. 

 The Spectrum Analyzer includes now timestamp. This feature allows knowing with 

millisecond precision the exact time data was captured, so it can be joined with GPS position 

data or other events. 

 The Remote Screen includes now timestamp. In addition to that, finer control were added to 

allow for B/W or color capture, as well as a text header with indication of capture time and 

model used on screen for reference. 

 A more advanced print facility, available from the File menu, allows now to print the Dark 

Mode configuration in white background to save toner and make prints easier to read. 

 The internal Spectrum Analyzer capture buffer is now able to store 10 million sweeps, 

thanks to new advanced memory management. 

 The internal Remote Screen capture buffer is now able to store 64K screens. 

 The buffer for Spectrum Analyzer and Remote Screen can be independently cleared from the 

File menu, Reinitialize Data Buffer command. It will ask for confirmation and will clear the 

buffer based on the current screen on focus. 

 RF Explorer data files include timestamp of each capture, so the persisted data is smarter 

and able to display capture time when restored. This include these file formats: 

o .RFE – standard RFE data files. 

o .RFS – standard RFS screen capture files. 

o .CSV – Cumulative CSV files include date and time on each sweep row. Simple CSV 

files remain with old format and no timestamp as they are compatible with 3rd party 

coordination software tools. 

 As result of these improvements, the file format is now v002 and therefore not readable 

from older versions of the RF Explorer for Windows. However, this new version of the 
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software can read older v001 format as well as new v002 format. If you deliver files to other 

users, make sure they work with the latest version of the software. 

 There are new sample files available in the Examples folder in the RF Explorer installation 

program group.  

 A new Help menu is available at the right of the menu bar. It includes direct access to online 

information, manuals and the About box. We are working on a much improved and updated 

version of the RF Explorer User Manual so all the information you may need will be just a 

click away. 

 A large number of workflows have been improved and bugs fixed based on user feedback 

and reports from different computer configurations. The continuous support of the RF 

Explorer community makes all these improvements possible, and we keep investing on 

making this software better and more capable based on feedback. 

 The underlying software SDK is now revamped in reusable components to make 3rd party 

integrations much easier. The foundation of all this functionality is the new 

RFECommunicator component, which encapsulates all the complexity of dealing with USB 

protocol for you. We will dedicate a full section in the documentation for reference of this 

powerful component which makes it possible to create your very own application in a few 

minutes, as well as integrate it with pre-existing software tools. As this is a layer on top of 

the standard USB communication protocol, you create applications and tools based on the 

low level documented protocol or with this new advanced control, your choice, both options 

are available. If you are interested on developing software for RF Explorer, place your 

questions and comments at www.rf-explorer.com/forum 

 

http://www.rf-explorer.com/forum
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Version 1.09.06 

Release date: CET Mar 21st, 2013 

This is a bug fixing release. It resolves a problem experienced by some users where the application 

will fail to load name settings from disk, and sometimes even crash. 
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Version 1.09.05 

Release date: CET Dec 14th, 2012 

This version includes a number of enhancements:  

 Internal memory buffer size increased to 30000 samples, previous versions limited it to 

10240 samples. Assuming an average of 10 samples/sec, you can get about an hour worth 

of data in the memory buffer. 

 New Continuous data log feature implemented, it is active by default in menu File-> 

Continuous Log to RFE data file – When this new feature is enabled, it will store 

information forever as long as there is enough HD space, creating successive .rfe data files 

automatically everytime the buffer gets filled and starting all over again. 

 

 If continuous data log is not active, the application won't store data automatically in files, 

but it will keep receiving signal data forever and won't stop when the buffer is full: it will just 

clear it and start all over again. Previous versions set the application On Hold and stopped 

capturing more data to protect the buffer from being overwritten. 

 Signal graph uses smoothed curves (splines) now in the Spectrum Analyzer screen, for a 

softer, more pleasant display. The splines have very little tension to avoid any distortion to 

the real signal data. 

Bug fixes included: 

 When connecting a RF Explorer with an old firmware version, it will show now a single 

popup with firmware version alert. Previous to this fix, there may be 2 or more popups with 

the same information displayed. 

 Named Settings file has been moved to a new location, in the AppData global folder where 

there is no access right restrictions to store application data. Previous to this fix, Windows 

Vista / Win7 and Win8 users with UAC enabled may experience problems storing named 

settings. When the new application version is loaded for the first time, it will import old 

named settings from the previous location, if it exists. In that way you do not lose the old 

settings when upgrading to the new application. 

 Named settings work fine now in both scenarios: RF Explorer unit connected and 

disconnected. Previous to this fix, certain combination of settings with the unit connected 

may not really honor the values on screen and will display bogus frequency information, as 

the RF Explorer unit and the Windows software may be not in sync. 



RF Explorer for Windows Cumulative Release Notes  page 21 

 

 Performance improved when loading very large .RFE files. Previous to this fix, the tool may 

take several minutes to load a RFE file with thousands of samples. 

 Reduced verbosity of the report tab window, to keep only meaningful information to the 

average user by default. If you need to enable detailed information, check the new Detailed 

Debug Info checkbox in the Report tab window anytime. Note detailed information is still 

persisted to Report log file, so it is available for client support and detail research in case of 

troubleshooting is required. 

 



RF Explorer for Windows Cumulative Release Notes  page 22 

 

Version 1.09.04 

Release date: CET Oct 10th, 2012 

This version includes a number of enhancement and bug fixes: 

 There is a powerful facility to persist configuration settings with descriptive names, so they 

can easily be restored on demand. You can use this powerful feature to easily setup the RF 

Explorer to configurations you commonly use. More information on this feature in the online 

manual at www.rf-explorer.com/windows in the “Configuration named settings” section. 

 The RF Explorer for Windows now exports a simplified CSV file format as required by IAS 

and other Frequency Coordination applications. For more information, please check details 

online here. You can also select the CSV delimiter (comma by default, but can be tabulator 

and other symbols). 

 There are now tooltips to help on understanding what the different functions and commands 

are for. 

 

 The user can now select the default location for data files (auto RFE file, bitmaps, CSV, etc) 

in the Configuration tab screen. By default it will go to My Documents\RFExplorer folder. 

 A bug that prevented the Peak values on screen to be exported the bitmap or being visible 

when the RF Explorer device was on hold has been resolved. This issue was introduced in 

previous version v1.09.03. 

 An internal adjustment on scale is now done automatically when a RFE file is loaded. This 

guarantee too low or too high amplitude signals will remain on screen after the file is 

loaded. 

 An optimization on the way the Remote Screen works is now in place, so the Auto LCD OFF 

feature disables the Remote Screen controls to make it more obvious to the user the fact 

that a remote screen is not available when the RF Explorer device doesn’t actually draw 

information on screen. 

http://www.rf-explorer.com/windows
http://micro.arocholl.com/index.php?option=com_content&view=article&id=64:rf-explorer-file-formats&catid=40:article&Itemid=64
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Version 1.09.03 

Release date: CET Aug 10th, 2012 

This version introduces the first contribution for an external developer; I want to thank Josef Jahn 

for implementing this nice first version of a Waterfall display on the RF Explorer Windows Client. If 

you have questions, suggestions you can contact him directly or put your question in the forum 

www.rf-explorer.com/forum . 

Josef developed a functional waterfall tab view and provided the following description: 

The waterfall view displays signal intensity across the scanned frequency range over time. 

This is different from the normal Spectrum Analyzer graph in that it allows the visualization 

of spread spectrum transmissions. Signal intensity is displayed via varying colors: Black and 

blue equal low signal strength, yellow and red are used for strong signal levels. The waterfall 

display scrolls up, with the latest data displayed at the bottom. 

Two sliders for "contrast" and "intensity" control how the data is displayed. These controls 

can be used to adjust the image for optimal visibility of the desired signal. The "intensity" 

slider controls the basic sensitivity, it's a constant multiplication factor that is best used to 

compensate for environments where the general signal noise level is high. The "contrast" 

slider controls the sensitivity of the waterfall diagram, and is typically used to emphasize low 

signal levels. For example, a weak signal can be made more visible by increasing the 

contrast. 

Manipulating both sliders allows for all kinds of signals to be displayed in the best possible 

and most visually apparent way. 

 

The waterfall display uses the maximum received values for the signal intensity. This means 

that changing the "Iterations" value on the "Spectrum Analyzer" tab will affect the data of 

the waterfall view. Small values for "Iterations" mean that short signal spikes are displayed 

as thin dots or horizontal lines, while larger values cause these lines to expand horizontally. 

 

The frequency range of the waterfall display is identical to the frequency range currently set 

on the "Spectrum Analyzer" tab. To examine narrow-band signals in more detail, set the 

frequency range accordingly on the Spectrum Analyzer tab - the waterfall view will reflect 

these changes. 

 

NOTE: Disable the RF-Explorer's LCD via settings for optimum performance and time 

resolution. This is particularly important for examining frequency hopping transmissions. 

mailto:josef.jahn@gmail.com
http://www.rf-explorer.com/forum
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This is an example of the waterfall view in action: First red bar is a 433Mhz single transmission, 

whereas the 5 bars at the bottom are sweep transmissions 1MHz apart. 

 

The last waterfall entries correspond to this Spectrum Analyzer view 

 

You can get more detailed activity with low Iteration number count in the analyzer view. 
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Version 1.09.02 

Release date: CET Jul 3rd, 2012 

This version introduces the following enhancements: 

 Quick toolbar access to a number of advanced functions on the right of the Spectrum Analyzer 

screen tab. 

 

 The configuration tab includes a frequency calibration functionality, see more info on the RF 

Explorer firmware v1.09 Beta 05 release notes, as well as this online demo video. 

 

http://micro.arocholl.com/images/stories/RFExplorer/Calibration/CalibrationPC.html
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 Support for the new WSUB3G model, covering frequencies from 15 to 2700MHz. See below an 

example of the WSUB3G model capturing commercial FM radio activity (88-108MHz) 

 

 Model and mode text is now embedded in the drawing area for easier reading and reference.  
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Version 1.06.09 

Release date: CET Nov 27th, 2011 

This version introduces the following enhancements: 

 Updated to get benefit of new features available in firmware v1.08 Beta 03. We strongly 

suggest upgrading your device. 

 New WiFi Analyzer screen. To use it, select WiFi Analyzer in your RF Explorer and a new 

graph mode bar will be displayed on the PC screen. 

 

 The application will select Max Peak mode automatically when switching to WiFi Analyzer, as 

this is the only real useful mode for WiFi analysis. 
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 New option to automatically switch the RF Explorer unit LCD OFF/ON using the new menu 

option shown below. This will work with firmware v1.08 beta 03 and newer only. 

 

 New Dark Mode skin, some users prefer graphs to be displayed over a black screen to better 

simulate a real instrument. You can switch it from normal to dark skin anytime with this 

menu option (Dark Color Mode): 

 

 RF Explorer Windows Client GUI now works on Tablet PCs with resolutions as low as 

1024x600. This feature was suggested by user Manuel Castro (Thanks!).  
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 To make it easier to display the graph in small screen resolutions, you can now disable the 

large control area (also known as ribbon in some applications) using menu option (Display 

Control Area):  

 

 There is a new Configuration window tab, where you should go when the Control Area has 

been disabled and you want to select different configuration options. This screen will be 

populated with future configuration options that may not be available in other screens. 
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 The application now can be also resized and maximized on screen to any resolution to make 

better use of large screens. 

 



RF Explorer for Windows Cumulative Release Notes  page 31 

 

 The Remote Screen has now additional Zoom values to make better use of larger screens, 

and includes a button to save a bitmap directly (same option as using the file menu but 

easier to use in a Tablet): 

 

 There is a feature under development to directly save screen images as video to share, but 

it is not finished and the “Save Video…” button will remain disabled in this version. 

 The Report window tab has been enhanced with a direct command feature to be used by 

developers and advanced users. The list of available commands is that published on the 

wiki, and can be pre-selected from a standard command list or sent from a custom 

combobox for those commands such as C2-F which need a set of custom values. This list 

will grow as we keep adding new features to remote control more functionality, and this 

Developer section is what you can use when the Arduino expansion board becomes 

available. 

 

  

http://code.google.com/p/rfexplorer/wiki/RFExplorerRS232Interface
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License 

RF Explorer embedded firmware is copyrighted © by Ariel Rocholl, 2010-2016  

RF Explorer for Windows is Open Source software released under GPL v3, so you are free to modify, 

distribute and use it based on GPL terms. Additional license options are available upon request. 

RF Explorer is a registered trademark in all EU and other Countries. 

 

Disclaimer 

This application is Open Source and available under GPL v3 license by Ariel Rocholl. The source 

code is available at http://github.com/arocholl/rfexplorer and can be modified, updated and 

redistributed under GPL license. 

For more info on RF Explorer, please visit  

www.rf-explorer.com  

For instructions to upload this new firmware in your RF Explorer unit, please visit online 

documentation at  

www.rf-explorer.com/upgrade 

Some of these new features documented below may not be available in the user manual until a 

final release is published. For questions, please go to RF Explorer forum at  

www.rf-explorer.com/forum 

You agree that the software is provided as-is, without warranty of any kind (either express or 

implied). Accordingly, we make no warranties, representations or guarantees, either express or 

implied, and disclaims all such warranties, representations or guarantees, including, without 

limitation, the implied warranties of merchantability and fitness for any particular purpose, as to: (a) 

the functionality or non-infringement of program, any modification, a combined work or an 

aggregate work; or (b) the results of any project undertaken using the program, any modification, a 

combined work or an aggregate work. In no event shall the contributors be liable for any direct, 

indirect, incidental, special, exemplary, consequential or any other damages (including, but not 

limited to, procurement of substitute goods or services; loss of use, data, or profits; or business 

interruption) however caused and on any theory of liability, whether in contract, strict liability, or 

tort (including negligence or otherwise) arising in any way out of the use of the program, even if 

advised of the possibility of such damages. You hereby waive any claims for damages of any kind 

against contributors which may result from your use of the firmware. 

http://github.com/arocholl/rfexplorer
http://www.rf-explorer.com/
http://www.rf-explorer.com/upgrade
http://www.rf-explorer.com/forum

